Note:
To change the product logo for your own print manual or PDF, click "Tools > Manual Designer" and modify the print manual template.
Title page 1

Use this page to introduce the product

by IPDS Printing Solutions SV

This is "Title Page 1" - you may use this page to introduce your product, show title, author, copyright, company logos, etc.

This page intentionally starts on an odd page, so that it is on the right half of an open book from the reader's point of view. This is the reason why the previous page was blank (the previous page is the back side of the cover)
Virtual IPDS Printer

© 2014 IPDS Printing Solutions SV

All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the written permission of the publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no responsibility for errors or omissions, or for damages resulting from the use of information contained in this document or from the use of programs and source code that may accompany it. In no event shall the publisher and the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused directly or indirectly by this document.

Printed: December 2014 in (wherever you are located)

Special thanks to:

All the people who contributed to this document, to mum and dad and grandpa, to my sisters and brothers and mothers in law, to our secretary Kathrin, to the graphic artist who created this great product logo on the cover page (sorry, don't remember your name at the moment but you did a great work), to the pizza service down the street (your daily Capricciosas saved our lives), to the copy shop where this document will be duplicated, and and and...

Last not least, we want to thank EC Software who wrote this great help tool called HELP & MANUAL which printed this document.

Publisher
...enter name...

Managing Editor
...enter name...

Technical Editors
...enter name...
...enter name...

Cover Designer
...enter name...

Team Coordinator
...enter name...

Production
...enter name...
# Table of Contents

Foreword 7  
**Part I** Introduction 9  
**Part II** Overview 11  
1 Features 12  
2 What is IPDS 13  
3 What is IPDS Printer 14  
4 What is non-IPDS Printer 16  
5 What is IPDS Emulation 17  
6 What is Virtual IPDS Printer 18  
**Part III** Installing 21  
1 System Requirement 21  
2 Before Install 21  
3 Silent Install 21  
4 Proxy Settings 22  
5 Central Deployment 22  
**Part IV** Configuring Virtual IPDS Printer 25  
1 Printer Mapping 25  
2 Printer Sharing 27  
3 Print Jobs 29  
4 Logging 30  
**Part V** Configuring IPDS Print Server 34  
1 Where to obtain IPDS Print Server software 35  
2 Folder and Printer Association 36  
3 IPDS Printing Emulation 37  
4 Configuration Wizard 39  
5 Printer Activities Logging 42  
6 Auto Launch on System Startup 44  
**Part VI** Archiving IPDS printing 46  
1 Creating an overlay 47  
2 Creating a document 48  
3 Creating a page segment 50  
4 Creating a medium overlay 53
<table>
<thead>
<tr>
<th>Part</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>VII</td>
<td>Output Options</td>
<td>56</td>
</tr>
<tr>
<td></td>
<td>1 Paper Size</td>
<td>56</td>
</tr>
<tr>
<td></td>
<td>2 Page Orientation</td>
<td>57</td>
</tr>
<tr>
<td>VIII</td>
<td>Clipping</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1 Clip Method</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>2 Clip Area</td>
<td>62</td>
</tr>
<tr>
<td></td>
<td>3 Medium Origin</td>
<td>63</td>
</tr>
<tr>
<td></td>
<td>4 Measurement</td>
<td>64</td>
</tr>
<tr>
<td>IX</td>
<td>Image Options</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>1 Color Options</td>
<td>68</td>
</tr>
<tr>
<td></td>
<td>2 Graphics Options</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>3 Grayscale Method</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>4 Compression Method</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>5 Intensity and Contrast</td>
<td>72</td>
</tr>
<tr>
<td>X</td>
<td>Font Options</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>1 EBCDIC</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>2 Use Text Rules</td>
<td>76</td>
</tr>
<tr>
<td></td>
<td>3 Maintain Text Order</td>
<td>77</td>
</tr>
<tr>
<td></td>
<td>4 Font Type</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>5 Text Support</td>
<td>79</td>
</tr>
<tr>
<td></td>
<td>6 Font Substitution</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>For Font</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>Use AFP Character Set</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>TrueType Font Options</td>
<td>83</td>
</tr>
<tr>
<td></td>
<td>7 Code Page</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>8 Output Fidelity</td>
<td>85</td>
</tr>
<tr>
<td>XI</td>
<td>Advanced Options</td>
<td>88</td>
</tr>
<tr>
<td></td>
<td>1 Image Resolution</td>
<td>88</td>
</tr>
<tr>
<td></td>
<td>2 Print text as image</td>
<td>89</td>
</tr>
<tr>
<td></td>
<td>3 Color Management</td>
<td>90</td>
</tr>
<tr>
<td></td>
<td>4 Compressed Images</td>
<td>90</td>
</tr>
<tr>
<td></td>
<td>5 Inline Form Definition</td>
<td>91</td>
</tr>
<tr>
<td></td>
<td>Duplex Options</td>
<td>92</td>
</tr>
<tr>
<td></td>
<td>Finishing Options</td>
<td>92</td>
</tr>
<tr>
<td></td>
<td>Destination Bin Options</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Medium Overlay Options</td>
<td>94</td>
</tr>
<tr>
<td></td>
<td>Form To Tray Assignment Options</td>
<td>94</td>
</tr>
</tbody>
</table>
Foreword

This is just another title page placed between table of contents and topics
Top Level Intro

This page is printed before a new top-level chapter starts
1 Introduction

User's Guide
for
Virtual IPDS Printer

(C) Copyright 2010-2015 IPDS Printing Solutions, S.V. All Rights Reserved

Top Level Intro

This page is printed before a new top-level chapter starts
2 Overview

This User Guide describes how to use Virtual IPDS Printer to emulate your existing Laserjet, Inkjet printer, or MFP device into an IPDS capable printer that fully supports the IPDS protocol.

Using this software emulation solution for IPDS printing, users can print reports of IBM IPDS data streams produced from a wide range of systems such as AS/400-i series IBM power- and mainframe-systems with a resolution up to 600 dpi, plus seamless emulation switching. Users also get tray and bin mapping and integrated-solution support features.

Virtual IPDS Printer, as its name indicates, is a pure software emulation solution for IPDS printing, which translates Intelligent Printer Data Stream directly into common printer languages eliminating the need for expensive investment on specialized hardware, extra software, and major reprogramming on the host side.

The Virtual IPDS Printer software installs a printer namely Virtual IPDS Printer to your printer list, and it enables fast and flexible printing from mainframe, midrange and other non-Windows host systems - such as UNIX, AIX, AS/400, IBM Power Series, System z, and Linux - to any Windows-based printers.

Easy to install and integrate, Virtual IPDS Printer simplifies cross-platform printing and central management of print jobs. With the help of IPDS to PDF (Portable Document Format) converter plug-in, users can print AFP / IPDS to PDF files without difficulty, thereby conserving bandwidth, and promoting fast transmission of print documents for previewing, printing and archiving.

Organizations using Virtual IPDS Printer will gain the benefits of increased efficiency, productivity and reduced cost.

This User Guide supplements the standard reference documents on IPDS printing by providing more specific “how to” information, such as diagrams, screen captures, and working examples. It addresses the IPDS printing from Microsoft Word, Microsoft Excel, Microsoft PowerPoint, Microsoft Visio, Microsoft Photo Wizard, Adobe Photoshop, and other print-enabling software.

This document is intended for customers, business partners, and systems specialists who need to understand the fundamentals of IPDS printing and IPDS emulation on the Microsoft Windows systems. It is designed to help you develop or advise others concerning the design and integration of IPDS solutions.
2.1 Features

Virtual IPDS Printer is an affordable software emulation solution for AFP/IPDS printing supporting the Intelligent Printer Data Stream (IPDS) protocol primarily used for printing large business reports, bar code labels, and invoices in high volumes.

Key features include,

- Support for AFP/IPDS over the LAN using TCP/IP
- Support for all IPDS data and resource towers
- Supports emulation of common IBM IPDS and SCS printers
- Share Virtual IPDS Printer as a network printer across your organizations
- Support for black-and-white printing and full color printing
- Conversion of the IPDS data stream done by host resources and increases print speeds.
- IPDS host printing and standard network printing is done in an Ethernet environment, eliminating the expense of a dedicated host AFP/IPDS printer
- Supports Advanced Function Printing (AFP) using native IPDS protocol
- Supports all AFP/IPDS Towers
- Uncompromized support for barcode, images, electronic forms, overlays, resource management, error recovery
- Host controlled printing and page range printing
- Flexible page positioning is provided without modifying the applications
- Device tray mapping
- Edge-to-edge printing on select printers
- Configuration via software control panel
- Support for traditional coax or twinax printing
- Using AFP/IPDS and PSF, capture fonts to hard disk or flash memory resulting in reduced network traffic over LAN, coax or twinax connections
- Support duplex printing and up to five paper input sources depending on host software
- Support for multiple output destinations
- The printer can be configured to take advantage of additional memory to improve performance for complex print jobs
- Archive IPDS print jobs and spooled files as AFP document, page segment, medium overlay, and overlay from any Windows application that supports printing (Print-To-File)
- Multiple Simultaneous Connections
- Support a complete set of paper sizes
- Define custom paper size
- Paper type includes White, Colored, Transparent
- Flexible page orientation such as Portrait, Landscape, Portrait 180, Landscape 270
- Clip unprintable area or offset plus size
- Grayscale methods include photographic dither, compressed dither, diagonal dither, line art halftone
- Color options for bitonal (B/W, Color/White), 16 colors (4bit CMYK from 4bit RGB or 24bit RGB), and Full Color 32bit CMYK
- Color Management with ICC Profiles
- Adjust image resolution between 300x300 and 600x600 dpi
- JPEG and LZW compression algorithm for images
- Support level of graphic objects that comply with GOCA's DR/2V0 standard
- Easy Intensity and Contrast Controls
- Best output fidelity for TrueType fonts as references, inline resources, or images
- Optimize text in OpenType fonts, raster fonts, and outline fonts
- Maintain Output Fidelity for placement in character, word, and line level
- Print Text as Graphics for printers not fully-compliant to PT2, PT3 standards
- Support EBCDIC code page
- Adjust Text Order when necessary
- Font substitution of AFP character set with closely matched Windows font
- Enable or disable Text Rules to trade off between speed, file size, and output fidelity
- Support Inline Form Definition
- Rich Duplex Options like Simplex, Duplex, Tumble Duplex
- Various Form To Tray assignment
- Finishing Options include Staple, Punch, Edge, Saddle
- Produce AFP output files as smaller as possible
- Change file extension for AFP documents, page segments, medium overlays, and overlays
- Import and export settings
- Automatic installation and configuration on Windows x86 and Windows x64
- Live update for new versions and plug-in on Windows 32bit and Windows 64bit
- Native support for 5000+ Windows applications
- No changes to host applications or printers
- Free upgrades in the future for registered users

2.2 What is IPDS

IPDS (Intelligent Printer Data Stream) is a host-to-printer data stream for AFP (Advanced Function Presentation) subsystems, which provides an attachment-independent interface for controlling and managing APA (all-points-addressable) printers that allows the presentation of pages containing an architecturally unlimited mixture of different data types, such as text, image, graphics, bar code, and object container.
The IPDS architecture, widely used by a variety of IBM, InfoPrint, and OEM print servers that drive APA page printers at medium and high end, allows for both spooled data and print job management to flow bidirectionally between the print server (or print driver) and the Printer Controller.

Print job management controls can be printer resolution, media jam, storage usage, duplexing capabilities, paper tray capabilities, Pre-processor, and post-processor exceptions.

Basic elements in spooled data are positioning information for locating objects within the page, text, images, graphics, bar code, fonts, inline forms, electronic overlays.

IPDS data streams, mainly binary encoded commands and parameters, are purely used to carry print information and data above the network transport layer (typically TCP/IP or SNA) and the supporting hardware LAN's, FC (Fiber Channels) as well as network controllers.

IPDS carries data and instructions from the print server to the printer in structured fields. The printer controller processes these IPDS commands and returns acknowledgment back to the print server.

2.3 What is IPDS Printer

IPDS printer is a printer that handles IPDS spooled files from AS/400, AIX, zSeries, iSeries, Mainframe and prints them on paper sheets.

List of IBM and InfoPrint printers with native support for IPDS

IBM 4028, 4312, 4317, 4324, 3112/3116, 3812, and 3816
IBM 3287
Infoprint 250
InfoPrint EMP156, InfoPrint SP 8200-DN1
Infoprint 20, Infoprint 21, Infoprint 32, Infoprint 40
Infoprint 45, Infoprint 60, Infoprint 70, Infoprint 70 Plus
Infoprint 62-002,003, InfoPrint 75, InfoPrint 100
Infoprint 1120, Infoprint 1125, Infoprint 1130
Infoprint 1140, Infoprint 1145, Infoprint 1145 MFP
Infoprint 1226, Infoprint 1332, Infoprint 1352
Infoprint 1372, Infoprint 1422, Infoprint 1532
Infoprint 1540 MFP, Infoprint 1552, InfoPrint 1552 MFP
Infoprint 1560 MFP, Infoprint 1570 MFP, Infoprint 1572
InfoPrint 1572 MFP, Infoprint 1580 MFP, Infoprint 1585
InfoPrint 1832, InfoPrint 1852, InfoPrint 1872
InfoPrint 1850 MFP, InfoPrint 1860 MFP
InfoPrint 1870 MFP, InfoPrint 1880 MFP
InfoPrint 1930 MFP, InfoPrint 1940 MFP
InfoPrint 2000-IPDS, AF1, AF2
InfoPrint 2060ES, InfoPrint 2075ES
InfoPrint 2090ES, InfoPrint 2105ES
InfoPrint 2085, InfoPrint 2105, InfoPrint 2235 (RPQ)
InfoPrint 2190, InfoPrint 2210
InfoPrint 3000-ED1, ED2, ES1
InfoPrint 4000-DR1, DR2, ID1, ID2, ID3, ID4, ID5, ID6, IR1, IR2, IR3, IR4, IS1, IS2
InfoPrint 4100-HS1, HS2, HD1/HD2, HD3/HD4, PS1, PD1/PD2
InfoPrint 4100-HS3, HD5/HD6
InfoPrint 4100-MS1, MD1/MD2
InfoPrint 4247-X03, Z03
InfoPrint 5000
InfoPrint 6500, InfoPrint 6700
InfoPrint Color 100, InfoPrint Color 130 Plus
InfoPrint Color 1220, InfoPrint Color 1228
InfoPrint Color 1354, InfoPrint Color 1357
InfoPrint Color 1454, InfoPrint Color 1464
InfoPrint Color 1567
InfoPrint Color 1654 Express, InfoPrint Color 1664
InfoPrint Color 1754 Express, InfoPrint Color 1764
InfoPrint Color 1764 MFP, InfoPrint Color 1767
InfoPrint Color 1759 MFP, InfoPrint Color 1769 MFP

List of HP printers with expansion DIMM card for IPDS

The following Laserjet and MFP printer can support monochrome IPDS printing once a DIMM Slot Expansion Card or Compact Flash or USB Thumbnail is inserted into the printer for monochrome IPDS emulation,

HP LaserJet M4345mfp
HP LaserJet M3035mfp
HP LaserJet M5035mfp
HP LaserJet M9040mfp
HP LaserJet M9050mfp
HP LaserJet P3005
HP LaserJet P3015
HP LaserJet P4014
HP LaserJet P4015
HP LaserJet P4515
HP LaserJet 2410
HP LaserJet 2420
HP LaserJet 2430
The following LaserJet and MFP printer can support full support IPDS printing once a DIMM Slot Expansion Card or Compact Flash or USB Thumbnail is inserted into the printer for full color IPDS emulation,

HP Color LaserJet 3800
HP Color LaserJet 3000
HP Color LaserJet CP6015
HP Color LaserJet CP3505
HP Color LaserJet CP3525
HP Color LaserJet CP4025
HP Color LaserJet CP4525
HP Color LaserJet CM3530mfp
HP Color LaserJet CM6030mfp
HP Color LaserJet CM6040mfp
HP Color LaserJet 4700
HP Color LaserJet 4730mfp
HP Color LaserJet 4650
HP Color LaserJet 5550
HP Color LaserJet 9500mfp
HP Color LaserJet CM4730mfp

2.4 What is non-IPDS Printer

IPDS printer is a printer that doesn't recognize the IPDS data stream or refused to receive print jobs in IPDS / AFP format. Most IBM, HP, Lexmark, Epson, Canon, Lexmark, Kodak, Ricoh, Sharp, Xerox, Konica, Kyocera-Mita, InfoPrint printers in the market are non-IPDS printer. Generally these printers recognize at least one PDL (Page Description Language) among PCL5, PCL6, PostScript, PostScript, and PDF but IPDS.

These non-IPDS printers can be further categorized into host-based printers and non-host-based printers.

Host-based printer is a printer that relies heavily on the host computer's processor to generate printable pages. Most host-based printers on the market today use the GDI interface built into Microsoft Windows, and that's why they are called GDI printer as well. Simply because they don't need a powerful processor of their own, host-based printers tend to be
less expensive than conventional printers. They share the host computer's processor, and therefore, they may be slow and slow down the host computer. How fast these printers operate depends on how powerful the host computer is and how occupied it is with other operations.

Non-host-based printer features their own processor, and the frequency of the processor varies greatly. We therefore have a variety of printers to choose on the market, low-end high, mid-ranged, and high-end printers.

Non-IPDS printers can well interpret IPDS print jobs and/or IPDS spooled files sent from IBM AS/400, AIX, zSeries, iSeries, and Mainframe thanks to the contribution of IPDS emulation. For more information on IPDS Emulation, read the next topic.

2.5 What is IPDS Emulation

Your enterprise might probably manage its business with legacy mainframe and midrange computer systems. You can also take advantage of distributing printing for workgroups without adding costly IPDS / AFP (Advanced Function Printing) compatible printers or replacing software applications.

An example of IPDS emulation is **software IPDS simulation**, that is to use a software package without additional investment on hardware to turn your existing laser printers or multi-function printer (MFP) devices into IPDS printers easily and reliably. The Virtual IPDS Printer software emulates your existing or new printers as IPDS printers in the way they process IPDS spooled files and print jobs sent directly from your IBM AS/400 - iSeries or Mainframe - zSeries hosts.

**Virtual IPDS Printer** and **IPDS Print Server** are two software programs that enable laser printers or multi-function printer (MFP) devices to print AFP/IPDS print jobs over an Ethernet LAN. This winning combination provides high level AFP/IPDS printing from an IBM AS/400 and Mainframe system.

There might be **hardware IPDS emulation** solutions out there such as the DIMM Card Solution, however, it requires you to invest heavily on the DIMM card to be inserted into your printer's memory slot.

**Virtual IPDS Printer** and **IPDS Print Server** software supports variety of non-IPDS printers from companies like IBM, HP, Lexmark, Epson, Canon, Lexmark, Kodak, Ricoh, Sharp, Xerox, Konica, Kyocera-Mita, and InfoPrint.
2.6 What is Virtual IPDS Printer

Virtual IPDS Printer installs a shared printer namely Virtual IPDS Printer, which allows users to print virtually any type of documents to this printer, and get the output on a mapped Laserjet, Inkjet, or Multi-function printer that doesn't support IPDS printing. In this way users can leverage their existing non-IPDS printers and perform high level AFP/IPDS printing from an IBM AS/400 and Mainframe systems over an Ethernet LAN.

Users can also archive their AFP/IPDS printing as an AFP file with the help of the provided Print-To-File feature. Users can also store the print result in Adobe PDF (Portable Document Format).

With AFP Server plug-in users can even email the AFP/IPDS printing result to others, upload it to a FTP server, copy or move it to a network location.

In summary Virtual IPDS Printer is a flexible electronic document
workflow solution for non-IPDS printers on various platforms.
Top Level Intro

This page is printed before a new top-level chapter starts
3 Installing

This chapter introduces the concept of software installation on Microsoft Windows, how to adjust proxy settings in a corporate environment, and how to deploy Virtual IPDS Printer in a centralized business environment.

3.1 System Requirement

Before installing the Virtual IPDS Printer software, please make sure that the following hardware requirements are met,

- Intel or AMD processor 1.6GHz or better
- 100MB free disk space
- 1024x768 or higher resolution for display

3.2 Before Install

Before installing Virtual IPDS Printer, make sure that you have Windows Print Spooler service enabled. This service is by default enabled by Microsoft Windows, and it is required by Virtual IPDS Printer as well as required by all Inkjet, Laserjet printers and MFP devices.

To enable the Print Spooler service, just click Start->Run, and type in the following command,

```
SC.EXE start Spooler
```

The file name of the installer for Virtual IPDS Printer is VirtualIPDSPrinter.exe. And the installer installs an evaluation copy of the Virtual IPDS Printer software for users to try for up to 15 days.

To facilitate the installation, you are required to log on Microsoft Windows as Administrator or a Power User with the rights to install software. After you download VirtualIPDSPrinterSetup.exe from the web or obtain the file from a 3rd-party source, you need to right-click on the file, and choose 'Run As Administrator' on Microsoft Windows 7 and later operating systems to ensure that the installer is executed with elevated privilege so that installation won't fail.

The file name 'VirtualIPDSPrinterSetup.exe' is for the trial version of Virtual IPDS Printer, and the one for the full retail version differs.

3.3 Silent Install

Virtual IPDS Printer can be installed in a completely silent way without any user interaction.
To start a silent installation, start the installer with the following switches,

VirtualIPDSPrinterSetup.exe /SP- /VERYSILENT

Sometimes a certain driver file might be in use by an application, and the file has to be replaced during next reboot. In this case, the installer might prompt user to restart the computer. To suppress the information, just use the following switches to initiate a silent install,

VirtualIPDSPrinterSetup.exe /SP- /VERYSILENT /NORESTART

If you need MSI package for installation, feel free to contact support@ipdsprinter.com.

3.4 Proxy Settings

The installer of Virtual IPDS Printer always perform a check to see if a newer version of the IPDS print driver is available on the web, and therefore an active Internet connection is strongly desired by the installer.

In a corporate environment the users have to specify a proxy server to have access to the Internet in the web browser. The installer for Virtual IPDS Printer is able to detect the proxy settings specified in Microsoft Internet Explorer.

If you haven't set up your proxy server, you can click Start->Run, and then type in the following command,

Rundll32 Shell32.dll,Control_RunDLL Inetcpl.cpl,,4

and then specify the proxy server name (or IP address), and the proxy server port.

3.5 Central Deployment

To deploy Virtual IPDS Printer on several servers across your organizations, printer sharing is the prerequisites. You can deploy the Virtual IPDS Printer in your client logon script or have your client users to double-click the shared Virtual IPDS Printer installed on your server, and create a local printer connection to this printer so that all your client computers would benefit from the IPDS printing capabilities.

If you are looking for a product that allows your client users to drop IPDS / AFP files into certain folders and immediately get these files printed out to certain printers, you may consider our IPDS Print Server
software.

For more information, read this page,

http://www.ipdsprinter.com/ipds-print-server.html

IPDS Print Server software creates a separate folder for each non-IPDS printer, users can copy or upload their IPDS / AFP files to a folder and get these documents printed out on paper sheets via the corresponding printer.
Top Level Intro

This page is printed before a new top-level chapter starts
4 Configuring Virtual IPDS Printer

This chapter introduces how to set up Virtual IPDS Printer and associate it with a non-IPDS printer.

Four sub topics are included in this chapter,

- Printer Mapping
- Printer Sharing
- Print Jobs
- Logging

Before covering the above topics, users need to get familiar with the user interface of the Virtual IPDS Printer configuration manager,

![Virtual IPDS Printer Configuration Interface]

4.1 Printer Mapping

It is important to understand the concept of printer mapping. Printer mapping is the association of Virtual IPDS Printer with a non-IPDS
printer be it a Laserjet printer, Inkjet printer, Dot matrix printer, AiO (All-in-One) printer, or a MFP (Multi-functional printer) devices.

Let's take the following 6 printers as an example,

On this computer we have three printers, one Virtual IPDS Printer, one AFP Printer, two EPSON non-IPDS printers, and one Fax printer, and one XPS printer. As is known both Fax and Microsoft XPS Document Writer printer are virtual printers. Users can print any type of document to this Fax printer to get the document faxed; they can print to this Microsoft XPS Document Writer printer to get printing result archived in XPS document format.

When users print their documents to the AFP Printer, they get printing archived in AFP / IPDS format, i.e. the AFP files.

Now let's associate the Virtual IPDS Printer with EPSON Stylus Pro 9800 printer,

1. Double-click Virtual IPDS Printer on your Desktop.
2. Choose Target Printer from the drop-down list, here the target printer should be the EPSON Stylus Pro 9800 printer.
3. Enable logging if you prefer.
4. Make sure you have checked the Share Virtual IPDS Printer for IBM
AS/400, Mainframe, iSeries, zSeries option.
5. Specify a temporary folder to cache the IPDS print jobs before they are sent to the EPSON printer.
6. Click Apply button to apply the changes we have just made.

Now Virtual IPDS Printer has been associated with EPSON Stylus Pro 9800 printer, and we have completed printer mapping.

Anything you print to Virtual IPDS Printer will be actually printed to EPSON Stylus Pro 9800 printer. It is time that you print your financial reports from an IBM AS/400 or Mainframe system to this shared Virtual IPDS Printer across your network, and eventually get the printing presented on paper sheets by EPSON Stylus Pro 9800 printer.

4.2 Printer Sharing

The printer sharing is enabled when the icon of the Virtual IPDS Printer is attached with a small sub-icon at the bottom-left corner, as illustrated,
To enable or disable printer sharing, you can add a tick or remove the tick before the 'Share Virtual IPDS Printer for IBM AS/400, Mainframe, iSeries, zSeries' option in the configuration manager of the Virtual IPDS Printer software.
To launch the configuration manager you need to double-click the Virtual IPDS Printer icon on your Desktop or navigate from Start->Programs->Virtual IPDS Printer->Virtual IPDS Printer.

After you change whether or not to share printer, you are required to click Apply button to apply the changes you have just made.

4.3 Print Jobs

When you print a document to Virtual IPDS Printer from either a Windows application or an IBM AS/400 application, the document is converted into AFP/IPDS printing format, and stored as a temporary file with an increased number as the postfix in a cache folder of your preference.

This cache folder, by default, is C:\IPDS, and you may change it to any folder of your choose. You are opt to delete the temporary files as you send more and more print jobs to the Virtual IPDS Printer by checking the 'Delete print job when done' option.
After you change the cache folder or the option whether or not to delete print job when done, you are required to click Apply button to apply the changes you have just made.

Now Virtual IPDS Printer has been associated with EPSON Stylus Pro 9800 printer

4.4 Logging

It is wise to enable logging to track how Virtual IPDS Printer works and whether it is working as expected.

You can simply check the 'Enable logging' option, and provide a log file. By default the log file is VirtualIPDSPrinter.log located in the install folder.

You can always keep the log file small by setting up the upper-bound value like 2 megabytes.

The 'Append date information to log file name' option, once checked,
will append date and time information to the end of the log file name. This feature is requested by some corporate IT Administrators to manage log files more easily.

The 'Delete log file older than N days' option allows for the erase of outdated log files. This option can only be activated when the 'Append date information to log file name' option is enabled.

After you change the cache folder or the option whether or not to delete print job when done, you are required to click Apply button to apply the changes you have just made.

Suppose you have enabled logging by checking the 'Enable logging' option, and after you click Apply button to make the changes to your system, you will see the following printer activities logging tool,
This tool automatically loads itself on system startup if you check the 'Enable printer activity logging on system startup' option.
Top Level Intro
This page is printed before a new top-level chapter starts
5 Configuring IPDS Print Server

This chapter introduces how to set up IPDS Print Server software and associate one hot folder with each non-IPDS printer. Unlike Virtual IPDS Printer software that only turns one non-IPDS printer into an IPDS printer, IPDS Print Server software can emulate IPDS printing for up to 255 non-IPDS printers on a host computer. The host computer can be a Windows server or a high-performance Windows workstation.

Six sub topics are included in this chapter,

- Where to obtain IPDS Print Server software
- Folder and Printer Association
- IPDS Printing Emulation
- Configuration Wizard
- Printer Activities Logging
- Auto Launch on System Startup

Before covering the above topics, users need to get familiar with the user interface of the configuration manager of the IPDS Print Server software,
5.1 Where to obtain IPDS Print Server software

IPDS Print Server is included in the Virtual IPDS Printer software package as a courtesy to the Virtual IPDS Printer users. However, no shortcut for IPDS Print Server software is created on users' Desktop. To launch IPDS Print Server, users need to click Start->Programs->Virtual IPDS Printer->IPDS Print Server.

Some users want to emulate more than one printer for IPDS printing, therefore, IPDS Print Server standalone package is desired. The standalone package software can always be obtained from IPDS Printing Solutions SV company website,

http://www.ipdsprinter.com/ipds-print-server.html
5.2 Folder and Printer Association

IPDS Print Server creates an association between an input folder and a target printer. The input folder is used to receive drop-in IPDS printing jobs stored in AFP format or AFP/IPDS spooled format. Once an incoming AFP/IPDS file appears in the input folder, IPDS Print Server software immediately moves the file, process it, and then send it to the target printer. The target printer is a printer without IPDS printing support, be it a Laserjet printer, Inkjet printer, Dot matrix printer, or a MFP (Multi-function printer) of any brand. The association, sometimes called mapping, can also be expressed as an input folder being assigned to a non-IPDS printer for receive incoming IPDS/AFP files for printing.

An association consists of one input folder and one non-IPDS printer. Users can create as many associations as they want. The limit is 255 associations per host computer. IPDS Print Server bridges the gap between AFP/IPDS files and printers without IPDS printing capabilities.

Steps to create an association,

1. Choose a printer from the drop-down list of Target Printer
2. Check the 'Enable AFP and IPDS Printer Emulation' option
3. Specify an input folder (a.k.a hot folder)
4. Specify a done folder to store completed jobs (optional)
5. Specify the Queue Depth, usually it's 2 or 1.
We recommend the done folder to be created as a sub folder of the input folder, which would dramatically enhance the overall performance.

5.3 IPDS Printing Emulation

More details on IPDS printing emulation settings shall be given in this topic.

*Input Folder* is a hot folder await for incoming print jobs in AFP/IPDS format. The file extension can be anything among,

- AFP Document: *.afp, *.AFP
- AFP Page Segment: *.psg, *.PSG
AFP Medium Overlay: *.oly,*.OLY
AFP Overlay: *.oly,*.OLY
Form Definition: *.fde,*.FDE
JFIF: *.DOR,*.jpg, *.JPG,*.jfif,*.jpeg
GIF: *.DOR,*.gif,*.GIF
TIFF: *.DOR,*.tif,*.TIF,*.tiff,*.TIFF
CHARSET: *.240,*.300,*.OLN,*.oln,*.Oln,*.fnt
CODEPAGE: *.fnt
CODEDFONT: *.FNT

**Done Folder** is folder await for completed print jobs moved from Input Folder.

**Queue Depth** decides how many IPDS print jobs a printer can accommodate at a time, i.e. the maximum simultaneous jobs a printer can receive. This value is 2 by default, and if you find several print jobs get stuck in the print queue, just decrease the value to 1. For a high-performance Laserjet printer with adequate amount of memory, you can increase the value to 3 or 4 or even more.

**Delete AFP files from Input Folder without moving to Done Folder when printing completes** is an option to determine the behavior of the IPDS Print Server. When it is checked, all completed print jobs will be removed from the Input Folder and get erased; when it is unchecked, completed print job will be moved from the Input Folder to the Done Folder one by one.

**Enable AFP and IPDS Printer Emulation** is the most important switch to turn on or turn off the IPDS printing emulation for a target non-IPDS printer. When it is checked, all the above settings are in effect after **Start** button is clicked.

**Start** is a button to start IPDS emulation for selected target printers.

**Stop** is a button to stop the IPDS emulation. All printers lose the IPDS printing capabilities after the button is clicked.

**Help** is a button to launch this help file.

**About** is a button to show the copyright information.

**Wizard...** is a button to pop up the Configuration Wizard.

**Run this program on system startup** is an option to launch IPDS Print Server on system startup and minimize its window.

**NOTE:** IPDS Print Server configuration manager should NOT be closed when IPDS emulation is in progress; otherwise, no emulation for any
5.4 **Configuration Wizard**

An input folder and a non-IPDS printer comprise an association for IPDS printing emulation. You can create as many associations as you want. However, you might probably need to configure a base folder, and each sub folder names after the emulated printer like,

C:\IPDSEmulation is the base folder
C:\IPDSEmulation\EPSON Stylus Pro 7910 is the sub folder for EPSON Stylus Pro 7910 printer. Once a AFP/IPDS file comes into this folder, and it get printed out on EPSON Stylus Pro 7910 printer. It can be said that
this folder is assigned to the EPSON Sylus Pro 7910 printer, and this folder can be deemed as a tray of the printer.

The Configuration Wizard automates the boring work of association creation for IPDS emulation. You can select one or more printers in the drop-down list of Supported Printer, and click Next button to proceed to the following screen,
This summary dialog allows you to verify the associations. If nothing goes wrong, just click OK button to quit the Wizard, and all the settings will be exported from the Wizard to the following user interface,
It is vital to enable logging to track the way IPDS Print Server works and whether it is working as expected.

You can simply check the 'Enable logging' option, and provide a log file. By default it is **IPDS.log** located in the install folder.

You can always keep the log file small by setting up the upper-bound value like 500 megabytes.

The 'Append date information to log file name' option, once checked, will append date and time information to the end of the log file name.
This feature is requested by some corporate IT Administrators.

The 'Delete log file older than N days' option allows for the erase of outdated log files. This option is only active when the 'Append date information to log file name' option is checked.

After you change the cache folder or the option whether or not to delete print job when done, you are required to click Start button to make the changes you have just made. Changes made when Start button is grayed out would take effect only after Stop button is pressed followed by another click of Start button.
5.6 **Auto Launch on System Startup**

You can enable 'Run this program on system startup' if you want IPDS Print Server to automatically load itself on system startup.

**Important Note:** IPDS Print Server would not work if you close the application, however, you can minimize it at any time.
Top Level Intro

This page is printed before a new top-level chapter starts

Part VI
6 Archiving IPDS printing

IPDS printing results can be archived in AFP (Advanced Function Presentation) format with the AFP printer driver, which is a printer driver designed to produce AFP output from Microsoft Windows applications.

AFP docs make it possible to print PC documents on high-speed AFP system printers, produce electronic forms using your favorite PC application, and even create signatures and logos from existing or newly-scanned sources.

AFP docs can be created on a PC with Microsoft Windows installed. Creating AFP docs is as simple as printing.

AFP docs are categorized by output type as document, page segment, medium overlay, and overlay.

- **AFP documents**

Using the AFP Printer, you can send your PC documents, such as Microsoft Word document, Microsoft Excel document et al, for printing on a high-speed AS/400 AFP system printer instead of overloading your desktop PC printer.

- **Page segments**

Page segments are collections of predefined data that can be merged with other data on a page when the page is printed. They generally are used to print signatures or logos. Page segments may contain either IM images, IO images, vector graphics, and, with some limitations, pre-composed text.

IM images are supported on all AFP Advanced Function Presentation printers. An IM image object specifies the content of an uncompressed raster image and its placement on a page. It is resolution and orientation. However, when printed on a printer of a different resolution from the image, if the printer supports IO images, the IM image is converted to IO image and scaled to the printer's resolution. This is done for most 300-dpi printers when 240-dpi images are used.

IO images are supported only on the newer AFP Advanced Function Presentation printers. An IO image object (also known as IOCA), also specifies the content of a raster image. However, the image is resolution independent and can be either uncompressed or compressed with one of the following compression algorithms: IBM MRR, RL4, ABIC, G3MR (CCITT T.4 G3) and G4 MRR (CCITT T.6 G4). If IO images are used for printers that do not support them, the images will be scaled to the
printer's resolution, if necessary, and converted to an IM image at print time.

Graphics are supported on only the newer AFP Advanced Function Presentation printers. They are not supported on old printers. A graphic object specifies the content of a vector graphic and it, too, is resolution independent.

If you already have your business logos or signatures in PC format, you can include these in overlays, or perhaps create them as a separate resource, i.e. an AFP page segment. Captured at a PC-attached scanner, they can be imported into a PC application and then “printed” as a page segment.

**Overlays and Medium Overlays**

An overlay may be either a medium overlay or a page overlay (page overlay is usually called **overlay**). Not all printers can support page overlays electronic forms.

The most common overlay is the **medium overlay**, which can be used to print same overlay on every page of data, print different overlays electronic forms on different copies of the same page, or print different overlays electronic forms on front and back of duplex page. It's a type of overlay that is called out in a form definition to be included on one or more pages of a document when it prints.

A page **overlay** is used to print different overlays electronic forms on different pages of a job, and/or print same overlay at different locations on different pages.

### 6.1 Creating an overlay

**What is AFP overlay?**

An overlay may be either a medium overlay or a page overlay (page overlay is usually called **overlay**). Not all printers can support page overlays electronic forms.

A page **overlay** is used to print different overlays electronic forms on different pages of a job, and/or print same overlay at different locations on different pages.

**How to create AFP overlay?**

1. Start your PC software (Here, we take Microsoft Excel as an example)
2. Open a Microsoft Excel spreadsheet
3. Select from main menu "File"->"Print"

4. Select Printer "AFP Printer"

5. Click the "Property" button on the right, and the follow window appears,

6. Select "Overlay" from the drop-down list of "Output Type"

7. Click "Apply" button and then click "OK" button to confirm your changes

8. Click "OK" in the Print Dialog of Microsoft Excel to confirm your "Print" command

9. A "Save-As" dialog will pop up, you can specify the folder and file name of the AFP document to be created.

6.2 Creating a document

What is AFP document?

Using the AFP Printer, you can send your PC documents, such as
Microsoft Word document, Microsoft Excel document et al, for printing on a high-speed AS/400 AFP system printer instead of overloading your desktop PC printer.

**How to create AFP document?**

1. Start your PC software (Here, we take Microsoft Word as an example)
2. Open a Microsoft Word document
3. Select from main menu "File"->"Print"
4. Select Printer "AFP Printer"
5. Click the "Property" button on the right, and the follow window appears,

6. Select "Document" from the drop-down list of "Output Type"

7. If you want to specify duplex printing and use a different drawer, highlight "Inline Form Definitions" and then click the "Form Definition..." button on the right,
You will get the **Inline Form Definition** dialog,

8. You can also specify an AFP (Medium) Overlay to be printed with your document, but you must ensure it is available as a separate resource on the system from which you want to print.

9. Click "OK" button to close the **Inline Form Definition** dialog.

10. Click "Apply" button and then click "OK" button to confirm your changes

11. Click "OK" in the Print Dialog of Microsoft Word to confirm your "Print" command

12. A "Save-As" dialog will pop up, you can specify the folder and file name of the AFP document to be created.

### 6.3 Creating a page segment

**What is AFP page segment?**

Page segments are collections of predefined data that can be merged with other data on a page when the page is printed. They generally are used to print signatures or logos. Page segments may contain either IM images, IO images, vector graphics, and, with some limitations, pre-composed text.
IM images are supported on all AFP enabled printers. An IM image object specifies the content of an uncompressed raster image and its placement on a page. It is resolution and orientation. However, when printed on a printer of a different resolution from the image, if the printer supports IO images, the IM image is converted to IO image and scaled to the printer's resolution. This is done for most 300-dpi printers when 240-dpi images are used.

IO images are supported only on the newer AFP enabled printers. An IO image object (also known as IOCA), also specifies the content of a raster image. However, the image is resolution independent and can be either uncompressed or compressed with one of the following compression algorithms: IBM MRR, RL4, ABIC, G3MR (CCITT T.4 G3) and G4 MRR (CCITT T.6 G4). If IO images are used for printers that do not support them, the images will be scaled to the printer's resolution, if necessary, and converted to an IM image at print time.

Graphics are supported on only the newer AFP enabled printers. They are not supported on old printers. A graphic object specifies the content of a vector graphic and it, too, is resolution independent.

If you already have your business logos or signatures in PC format, you can include these in overlays, or perhaps create them as a separate resource, i.e. an AFP page segment. Captured at a PC-attached scanner, they can be imported into a PC application and then “printed” as a page segment.

**How to create AFP page segment?**

1. Start your PC software (Here, we take Microsoft Access as an example)
2. Open a Microsoft Access database/document
3. Select from main menu "File"->"Print"
4. Select Printer "AFP Printer"
5. Click the "Property" button on the right, and the follow window appears,
6. Select "Page Segment" from the drop-down list of "Output Type"

7. Click "Apply" button and then click "OK" button to confirm your changes

8. For an image that occupies most or all of the page, leave the Top/Left and Width/Height settings at their default values. If you are producing a company logo or signature that typically occupies a small area of the page, you can place your logo in the top left-hand area of the page, and then change Paper Size to User Defined (for instance, 2.0 inches wide by 1.2 inches deep). This helps reduce the amount of surrounding white space you capture with the page segment and makes positioning it much easier.

8'. Alternatively, you can enter the coordinates of the top left-hand corner of the logo or area you want to capture in Top and Left in "Clip Limits..." options dialog, and change Width and Height as required (for instance, 2.0 inches by 1.2 inches). NOTE: This method does not work with certain Windows applications

8". Another method is to select the Partial Print option from your Windows application, which means that you print only an area of your spreadsheet or drawing, but not the whole area.
9. Click "OK" in the Print Dialog of Microsoft Access to confirm your "Print" command

10. A "Save-As" dialog will pop up, you can specify the folder and file name of the AFP document to be created.

6.4 Creating a medium overlay

What is AFP medium overlay?

An overlay may be either a medium overlay or a page overlay (page overlay is usually called overlay). Not all printers can support page overlays electronic forms.

The most common overlay is the medium overlay, which can be used to print same overlay on every page of data, print different overlays electronic forms on different copies of the same page, or print different overlays electronic forms on front and back of duplex page. It's a type of overlay that is called out in a form definition to be included on one or more pages of a document when it prints.

How to create AFP medium overlay?

1. Start your PC software (Here, we take Microsoft PowerPoint as an example)

2. Open a Microsoft PowerPoint slide

3. Select from main menu "File"-"Print"

4. Select Printer "AFP Printer"

5. Click the "Property" button on the right, and the follow window appears,
6. Select "Medium Overlay" from the drop-down list of "Output Type"

7. Click "Apply" button and then click "OK" button to confirm your changes

8. Click "OK" in the Print Dialog of Microsoft PowerPoint to confirm your "Print" command

9. A "Save-As" dialog will pop up, you can specify the folder and file name of the AFP document to be created.
Top Level Intro

This page is printed before a new top-level chapter starts
7 Output Options

The IPDS/AFP drivers differ from normal printer drivers in that the output is Advanced Function Presentation Data Stream (AFPDS) instead of the more usual Printer Control Language (PCL), Personal Printer Data Stream (PPDS), PostScript, and others. You “print” to the AFP Printer to obtain the output in an AFP file just the same way as you normally print from any Windows application to an Inkjet or Laserjet printer.

There are a variety of output options, among which the most important options are paper size and page orientation.

Paper size specifies which type of media your document is printed on, for example, print each your Microsoft Word document page to an A4 size paper represented in an AFP document.

Page orientation describes the layout of your document, portrait or landscape or even complex.

7.1 Paper Size

To adjust the paper size settings, you can run the following command in Start->Run,

rundll32.exe printui.dll, PrintUIEntry /e /n "AFP Printer"

Or you can go to your Control Panel->Printers and Devices (only on Windows 10/8.1/8/7/Vista/2008/2012/2015) or Control Panel->Printers and Faxes (only on Windows 2000/XP/2003), and right-click on the "AFP Printer", and then choose "Printing Preferences".

In the Printing Preferences dialog, you see the Paper Size option.

The following paper sizes are supported by the AFP Printer,

Letter (8.5 x 11 inch)
Legal (8.5 x 14 inch)
Ledger (17 x 11 inch)
Executive (7.25 x 10.5 inch)
Tabloid (11 x 17 inch)
Statement (5.5 x 8.5 inch)
A3 (297 x 420 mm)
A4 (210 x 297 mm)

A4 Small (210 x 297 mm)
A5 (148 x 210 mm)
B4 (250 x 354 mm)
B5 (182 x 257 mm)
Folio (8.5 x 13 inch)  
Quarto (215 x 275 mm)  
Note (8.5 x 11 inch)  
10 x 14 inch  
11 x 17 inch  
Envelope B4 (110 x 230 mm)  
Envelope B5 (176 x 250 mm)  
Envelope B6 (176 x 125 mm)  
Envelope C3 (324 x 458 mm)  
Envelope C4 (229 x 324 mm)  
Envelope C5 (162 x 229 mm)  
Envelope C6 (114 x 162 mm)  
Envelope C65 (114 x 229 mm)  
Envelope DL (110 x 220 mm)  
Envelope #9 (3.875 x 8.875 inch)  
Envelope #10 (4.125 x 9.5 inch)  
Envelope #11 (4.5 x 10.375 inch)  
Envelope #12 (4.75 x 11 inch)  
Envelope #14 (5 x 11.5 inch)  
Envelope Monarch (3.875 x 7.5 inch)  
C Sheet  
D Sheet  
E Sheet  
Continuous (13.2 x 8.5 inch)  
Continuous (13.2 x 11 inch)  
Continuous (13.2 x 14 inch)  
**User Defined** (When this item is chosen, you are required to click the "User Defined..." button on the right and specify the height, width, and unit.)

**NOTE:** The paper size that you enter must exist on your printer, or printing any documents that are created with this paper size may fail. Neither height nor width must exceed the range of [1, 22].

### 7.2 Page Orientation

The following page orientation are supported by the AFP Printer,

- Portrait
- Landscape
- Portrait 180
- Landscape 270
To adjust the page orientation settings, you can run the following command in Start->Run,

```
rundll32.exe printui.dll, PrintUIEntry /e /n "AFP Printer"
```

Or you can go to your Control Panel->Printers and Devices (only on Windows 10/8.1/8/7/Vista/2008/2012/2015) or Control Panel->Printers and Faxes (only on Windows 2000/XP/2003), and right-click on the "AFP Printer", and then choose "Printing Preferences".

In the Printing Preferences dialog, you see the **Orientation** option.
Top Level Intro

This page is printed before a new top-level chapter starts
8 Clipping

AFP Printer offers a **Clip Limit Options** dialog to indicate how the AFP Printer should clip the output generated.

To show this dialog, you can run the following command in Start->Run,

```
rundll32.exe printui.dll, PrintUIEntry /e /n "AFP Printer"
```

Or you can go to your Control Panel->Printers and Devices (only on Windows 10/8.1/8/7/Vista/2008/2012/2015) or Control Panel->Printers and Faxes (only on Windows 2000/XP/2003), and right-click on the "AFP Printer", and then choose "Printing Preferences".

In the Printing Preferences dialog, you see an option "Clip Limits..." and a button "Properties..." on the right,

![Advanced Tab](image)

Click this button, and you will get the **Clip Limit Options** dialog,
8.1 Clip Method

Two kinds of clip methods are provided in AFP Printer,

Unprintable area:

This method is intended for document and medium overlays. You need to specify the amount of unprintable area on the top and bottom of the page, and for the left and right margins. For instance, the default margin in your printer is set to one quarter of an inch on all sides, but you may want to decrease this amount to take advantage of your printer’s ability to print closer to the edge.

Offset plus size:

This method is for page segments and overlays. You are required to specify the coordinates of the top-left corner of the area to be included in the page segment or overlay and the width and height of the area.

The following formula should be met,

1. Left offset + Width <= paper width
2. Top offset + Height <= paper height
8.2 Clip Area

You can set the area for the actual amount to clip. The value ranges are determined by the clip method selected.

The Top value determines how much to clip off the top of the page.

The Left value determines how much to clip off the left of the page.

The Bottom value determines how much to clip off the bottom of the page.

The Right value determines how much to clip off the right of the page.

The Width value determines how wide the clipped output should be.

The Height value determines indicates how high the clipped output should be.
Medium Origin options **disappear** when the **Inline Form Definition** is set to **On**, because the medium origin always equals to \((0,0)\) in the inline form definition to be created.
8.4 Measurement

The unit of measurement can either be Inch or Millimeter. You can choose the one of your preference.
Clipping

Clip Method
- Unprintable area
- Offset plus size

Medium Origin
- X: 0.000
- Y: 0.000

Top: 0.000
Left: 0.000
Right: 0.000
Bottom: 0.000

Units
- Inches
- Millimeters

OK  Defaults  Cancel  Help
Top Level Intro

This page is printed before a new top-level chapter starts
9 Image Options

AFP Printer offers an Image Options dialog to indicate how the AFP Printer should process images and graphics before generating the output.

When you print from some Windows applications to the AFP printer, they do not send halftone data directly to the printer, and the options you select for Color Options, Graphics Options, Grayscale Method, Compression Method, Intensity, and Contrast determine how your images and graphics are printed.

You may need to experiment with these options to get the best results.

To show this dialog, you can run the following command in Start->Run, rundll32.exe printui.dll, PrintUIEntry /e /n "AFP Printer"

Or you can go to your Control Panel->Printers and Devices (only on Windows 10/8.1/8/7/Vista/2008/2012/2015) or Control Panel->Printers and Faxes (only on Windows 2000/XP/2003), and right-click on the "AFP Printer", and then choose "Printing Preferences".

In the Printing Preferences dialog, you see an option "Image Options..." and a button "Properties..." immediately on the right of the option,

Click this button, and you will get the Image Options dialog,
9.1 Color Options

Four kinds of Color Options are available. The color option that you select determines how your AFP document (*.AFP), page segment (*.PSG), medium overlay (*.OLY), or overlay (*.OLY) looks like.

Back / White (B/W)
This bitonal option forces the AFP Printer to generate black and white images. Only black and white are available in the output AFP docs.

Color / White (C/W)
This bitonal option mandates the AFP Printer to generate single color and white images. Only the selected single color and white are available in the output AFP docs. The single color is Black by default, and you may change it to other colors but White as well.

16 Colors - 4Bit CMYK / From RGB
This option allows the creation of 16 colors images in the CMYK Color Space. The halftone algorithm is selected by the number of bits, either 4Bit or 32Bit, in the RGB Color Space.

Full Colors - 32Bit CMYK
This option allows the creation of 32-bit full-color image in the CMYK Color Space.

NOTE: CMYK stands for Cyan, Magenta, Yellow, and Black, and RGB is short for Red, Green, and Blue.
9.2 Graphics Options

Graphic Options determines the support level of graphics the AFP Printer generates. Three options are provided:

**None**
All graphic objects are rasterized into images.

**Basic**
Graphic objects comply with GOCA's DR/2V0 standard, which is a standard supported by all AFP enabled printers.

**Enhanced**
Graphic objects have additional drawing orders not support by GOCA's DR/2V0 standard. Not all AFP enabled printers support the additional drawing orders.

**NOTE**: GOCA is an architected collection of constructs for the interchange and presentation of graphic data. The AFP Printer uses constructs from the GOCA DR/2V0 and above.
9.3 **Grayscale Method**

Five grayscale methods are provided,

**Default Dither**
This method uses a 4 x 4 bit pattern of dots to emulate up to 16 levels of gray.

**Photographic Dither**
This method uses an 8 x 8 bit pattern of dots to emulate up to 64 levels of gray, producing a smooth, realistic, and photographic appearance. If you need soft contrasts between various shades of gray, you should not miss this dither.

**Compressed Dither**
This method uses an 8 x 8 bit pattern of horizontal lines to emulate up to 64 levels of gray, producing the smallest output, while still giving reasonable quality. This dither should not be applied to the full color images produced by a scanner.

**Diagonal Dither**
This method uses an 8 x 8 bit pattern of diagonal lines to emulate up to 64 levels of gray, producing a smooth, realistic appearance without the graininess otherwise produced using the Photographic Dither.

**Line art halftone Dither**
This method uses 32 different 8 x 8 bit patterns to produce 32 distinct levels of gray. Line art halftone Dither works well for images with intricate lines and fine detail such as clip art graphics. Unlike Photographic Dither and Diagonal Dither that provide soft contrasts
between various shades of gray, the Line art halftone Dither provides solid lines and well-defined borders between various shades of gray.

9.4 Compression Method

This option, for most cases, is grayed out, unless the Full Color - 32Bit CMYK Color option is selected as the color option for AFP docs.
Full color image objects can be compressed using either the LZW or the JPEG compression algorithm. LZW compression is good for text-based content, and JPEG compression is recommended for photographic images.

9.5 Intensity and Contrast

Intensity Control and Contrast Control are grayed out when the grayscale method is Default dither; they are enabled when any other dither is selected as the grayscale method.

Intensity Control can be used to increase or decrease the lightness of image and graphics in the output AFP docs.

Contrast Control can be used to increase or decrease the contrast of image and graphics in the output AFP docs.

In most cases the two values do not need to be adjusted.
Top Level Intro
This page is printed before a new top-level chapter starts

Part X
10 **Font Options**

AFP Printer offers an **Font Options** dialog to indicate how the AFP Printer should process fonts before generating the output.

When you print from some Windows applications to the AFP printer, text printed in a certain font might not have a substitute in your table is printed as image. By setting up the Font Options, you can determine which AFP character set should be substituted for particular Windows fonts in your AFP output and what level of fidelity should be maintained.

You may need to experiment with these options to get the best results.

To show this dialog, you can run the following command in Start->Run, `rundll32.exe printui.dll, PrintUIEntry /p /n "AFP Printer"

In the Printing Preferences dialog, you see an option "Fonts..." and a button "Properties..." immediately on the right of the option,

![Device Settings](image)

Click this button, and you will get the **Font Options** dialog,
10.1 EBCDIC

Extended Binary Coded Decimal Interchange Code (EBCDIC) is an 8-bit character encoding (code page) employed mainly on IBM mainframe operating systems such as z/OS, OS/390, VM and VSE, as well as IBM midrange computer operating systems such as OS/400 and i5/OS (see also Binary Coded Decimal).

When the EBCDIC option is selected, the AFP Printer will convert all ASCII text into EBCDIC text. A valid EBCDIC code page must be specified in the Code Page column, or the text strings would otherwise print improperly.
The default EBCDIC code page is T1001140.

This EBCDIC option is by default disabled.

10.2 Use Text Rules

This **Use Text Rules** option allows you to trade off between speed, file size, and output fidelity.

When this option is enabled, the AFP Printer produces output files as smaller as possible. Smaller AFP files are usually printed faster by the target printer.
This option is by default enabled.

### 10.3 Maintain Text Order

This **Maintain Text Order** option determines the whether the AFP Printer should keep the text in the order it was received from the application where the Print command is issued.

When this option is enabled, the received text is kept in order; when it is disabled, the AFP Printer will order the text by font type and style improving performance as a result.
This option is by default disabled.

10.4 Font Type

Three options for Font Type are provided,

AFP Raster Fonts
AFP Outline Fonts
TrueType Fonts

We recommend **TrueType fonts** among the three options so as to get the best output fidelity. Some AFP enabled printers require that the printers are configured to accept TrueType fonts.

**AFP Raster Fonts** are fonts whose graphic character shapes are defined by small raster patterns.

**AFP Outline Fonts** are fonts fully compliant to the Adobe Type 1 Font standards, and graphic character shapes are defined by mathematical equations rather than by raster patterns.

Please check with your printer manufacturer to see if your AFP enabled printer supports TrueType fonts, Raster Fonts, and Outline Fonts.
10.5 Text Support

This Text Support option determines the support level of text the AFP Printer generates. Two options are available for Text Support, Basic and Enhanced Color.

Basic
Text objects generated from AFP Printer are compliant to PT2 standards.

Enhanced Color
Text objects generated from AFP Printer are compliant to PT3 standards.

NOTE: PT2 standards only support the eight colors, red, blue, green, black, magenta, cyan, yellow, and brown. Whereas PT3 standards support a full spectrum RGB color space, i.e. all the 24-bit color values. PT3 is not supported by all AFP enabled printers.
10.6 Font Substitution

You can substitute a font in your table with a Windows font in the Font Process Table frame.
The **Font Process Table** frame contains three sub-frames,

For Font
Use AFP Character Set
TrueType Font Options

10.6.1 **For Font**

Choose a font in the **For Font** sub-frame as a replacement for the font in your table.

**Name**
Specify the name of the Windows font such as Arial.

**Style**
Specify the style of the Windows font such as Regular, Italic, Bold.

**Size**
Specify the size of the Windows font selected.

When you select a font in the drop-down list of all the available fonts installed on your Microsoft Windows system, the current substitution for the selected font, if available, is shown in the **Use AFP Character Set** sub-frame, as illustrated, C0H200B0 is for shown for Arial.
10.6.2 Use AFP Character Set

Choose a font in the **For Font** sub-frame as a replacement for the font in your table.

When you select a font in the drop-down list of all the available fonts installed on your Microsoft Windows system, the current substitution for the selected font, if available, is shown in the **Use AFP Character Set** sub-frame. For example, C0H200B0 is a substitution for Arial.

You can add, modify, and delete a font substitution at any time. Any AFP character set that is substituted should have metrics that closely match the selected Windows font, or text in your AFP output will not be correctly placed. You can avoid some of these errors by varying the output fidelity.
10.6.3 TrueType Font Options

Three options are provided in the TrueType Font Options sub-frame.

Create Reference
This option directs the AFP Printer to create references for TrueType fonts, and it helps minimize the size of output files.

Create Inline Resource
This option directs the AFP Printer to embed a subset of TrueType fonts as inline resources in the AFP output, and thus produce larger output files.

Generate Image
This option directs the AFP Printer to rasterize the TrueType fonts and store fonts as image rather than text objects, and therefore create the largest output files.

Note: We recommend the Create Reference option for document without text in special fonts. We suggest the choice of the Create Inline Resource option for document with special fonts. We do not advice the use of the Generate Image option unless the target printer does not support TrueType fonts.
10.7 **Code Page**

Code page is another name for character encoding, which consists of a table of values describing the character set for a particular language. The term code page originated from IBM's EBCDIC-based mainframe systems.

The default code page for ASCII is T1001252 (Personal Computer: Desktop Publishing). You can enter your own code page to be used by the AFP Printer.

T1001252 works for most cases.
10.8 Output Fidelity

Like the **Use Text Rules** option, the **Output Fidelity** options can be used to trade off between speed, file size, and output fidelity.

Only text printed in substituted fonts will be impacted by the **Output Fidelity** options, whereas text printed as image will never be impacted.

Three methods are provided for Output Fidelity,

**Character**

This method places each character individually according to the metrics of the Windows font. Provides the greatest fidelity, it causes the driver to run slower and increases the size of your output file.

If the AFP character set that you are substituting has metrics that closely match your Windows fonts, this method is rarely used unless you do find incorrect character placement in the AFP output.

**Word**

This method places each word individually according to the metrics of the Windows font, thus providing a good compromise between speed, size, and fidelity. Recommended for most situations.
**Line**

This method places each line individually according to the metrics of the Windows font, thus generating the smallest output files that will be printed much faster.

Though this method might cause words to overlap in some cases, it provides considerable fidelity when your document is composed of individual lines in the same font and proper font substitutions have been set up in the AFP Printer.

![Font and Text Support Settings](image)

<table>
<thead>
<tr>
<th>Font Type</th>
<th>Text Support</th>
<th>Use Text Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFP Raster Fonts</td>
<td>Basic</td>
<td>□</td>
</tr>
<tr>
<td>AFP Outline Fonts</td>
<td>Enhanced Color</td>
<td></td>
</tr>
<tr>
<td>TrueType Fonts</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Font Process Table</th>
<th>Use AFP Character Set</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For Font</strong></td>
<td><strong>COH20080</strong></td>
</tr>
<tr>
<td>Name</td>
<td>Arial</td>
</tr>
<tr>
<td>Style</td>
<td>Regular</td>
</tr>
<tr>
<td>Size</td>
<td>12</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TrueType Font Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Reference</td>
</tr>
<tr>
<td>Create Inline Resource</td>
</tr>
<tr>
<td>Generate Image</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Output Fidelity</th>
<th>Code Page</th>
<th>EBCDIC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character</td>
<td>T1001252</td>
<td>□</td>
</tr>
<tr>
<td>Word</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[Image of software interface with font and text settings]
Top Level Intro

This page is printed before a new top-level chapter starts.

Part XI
11 Advanced Options

AFP Printer offers many advanced options to indicate how the AFP Printer should process images and graphics before generating the output. You may need to experiment with these options to get the best results.

To show this dialog, you can run the following command in Start->Run,

`rundll32.exe printui.dll, PrintUIEntry /e /n "AFP Printer"

In the Printing Preferences dialog, you see the option "Print Text as Graphics" and "Inline Form Definition".

![Document Options]

Color Management options are available in the Color Management tab of the AFP Printer Properties dialog, after you run the following command in Start->Run,

`rundll32.exe printui.dll, PrintUIEntry /p /n "AFP Printer"

Image Resolution and Compressed Images options can both be found in the "Device Settings" tab,

![Device Settings]

11.1 Image Resolution

Image Resolution can either be 300x300 or 600x600 DPI (Dot Per Inch). The principle of the choice is to match your target printer.
Most laserjet printers, such as IBM, Oce, InfoPrint printers, use AFP resources at 300 dpi even if they subsequently print the output at 600 dpi.

11.2 Print text as image

This option allows you to print text as vector-based font objects or rasterized images.

When this option is set to On, the AFP Printer processes text in your PC document as text wherever possible with graphics and shading being produced as image, and it makes it more efficient to produce text-based overlays and documents in terms of both the file size and the speed of viewing and printing.

When this option is set to Off, all text-based contents are processed as a series of images rather than as vector-based text.

We highly recommend this option to be set to On unless you find that certain text is missing or certain type of fonts are misinterpreted in the output AFP docs.
11.3 Color Management

Color Management options are only available on Microsoft Windows 10/8.1/8/7/Vista/2008/2012 or later operating systems, which can be found when you can go to your Control Panel->Printers and Devices, and right-click on the "AFP Printer", and then choose "Properties".

Color Management options are on the Color Management tab of the AFP Printer Properties tab, and you can specify an ICC profile for color space conversion.

11.4 Compressed Images

Compressed Images option is set to On by default. If you turn this option off, you get larger AFP document, page segment, or (medium) overlay.

Most laserjet printers, such as IBM, Oce, InfoPrint printers, is capable of decompressing images when a AFP document, page segment, or (medium) overlay is printed.

This option is set to Off only when the target printer is old and does not support image compression.
11.5 Inline Form Definition

AFP Printer offers an **Inline Form Definition Options** dialog to indicate how the AFP Printer should process images and graphics before generating the output.

You may need to experiment with these options to get the best results.

To show this dialog, you can run the following command in Start->Run, `rundll32.exe printui.dll, PrintUIEntry /e /n "AFP Printer"

Or you can go to your Control Panel->Printers and Devices (only on Windows 10/8.1/8/7/Vista/2008/2012/2015) or Control Panel->Printers and Faxes (only on Windows 2000/XP/2003), and right-click on the "AFP Printer", and then choose "Printing Preferences".

In the Printing Preferences dialog, you see an option "Inline Form Definition", turn it from Off to On, and a button "Form Definitions..." appears immediately on the right of the option,

Click this button, and you will get the **Inline Form Definition** dialog,
11.5.1 Duplex Options

Duplex Options are embedded parameters and/or commands in the AFP docs (document, page segment, overlay, or medium overlay) to indicate on which sides of the output sheet the target printer prints your AFP docs. The target printer can be a consumer inkjet printer, a high-volume laserjet printer, or a CMYK printing press.

**Simplex**

Print only one side on each output sheet.

**Duplex**

Print both sides on each output sheet and arrange the resulting sheets to be found on the left.

**Tumble Duplex**

Print both sides on each output sheet and arrange the resulting sheets to be bound on the top.

11.5.2 Finishing Options

Finishing Options are embedded parameters and/or commands in the AFP docs (document, page segment, overlay, or medium overlay) to indicate the type of task to do at the end of printing on a document level. For instance, if Punch is selected, and all the pages in a document are punched.

**Punch**

The following types of Punch operations are supported by AFP Printer,
Staple

The following types of Staple operations are supported by AFP Printer,

11.5.3 Destination Bin Options

Destination Bin Options are embedded parameters and/or commands in the AFP docs (document, page segment, overlay, or medium overlay) to indicate which output bin should be used by the target printer.

Zero stands for the default bin, and one stands for Bin 1, and two stands for Bin 2 etc.
11.5.4 **Medium Overlay Options**

Medium Overlay Options are embedded parameters and/or commands in the AFP docs (document, page segment, overlay, or medium overlay) to indicate which medium overlay is to be included on every page of your AFP document when the document is printed on the target printer. A valid name of the medium overlay is required.

11.5.5 **Form To Tray Assignment Options**

Form To Tray Assignment Options are embedded parameters and/or commands in the AFP docs (document, page segment, overlay, or medium overlay) to match the correct paper size with each paper source available on the target printer.

**Size**

A full list of available paper sizes.

**Source**

A complete list of valid paper sources available on the target printer. If the "Auto Select Bin" option is selected, Paper Type is matched to Size to determine the media object identifier.

**Paper Type**

White, Color, Transparent are the three available options.
Top Level Intro

This page is printed before a new top-level chapter starts

Part XII
12 Viewing IPDS/AFP

AFP document, page segment, medium overlay, and overlay can all be viewed by IBM AFP Workbench Viewer, a free program that help you view and print IPDS/AFP documents.

There exist many 3rd-party IPDS/AFP viewers, but some of them can not interpret or present IPDS/AFP data stream correctly.

12.1 IBM AFP Workbench Viewer

IBM AFP Workbench Viewer Plug-in for Microsoft Internet Explorer

IBM AFP Workbench Viewer Standalone application

Both the plug-in and the standalone application are able to view and print the AFP/IPDS document, page segment, medium overlay, and overlay with the following file extensions on Microsoft Windows 2000/XP/2003/Vista/7/8/10/2008/2012 and later operating systems.

Document: *.afp, *.AFP
Page Segment: *.psg,*.PSG
Medium Overlay: *.oly,*.OLY
Overlay: *.oly,*.OLY

The following type of resources are also supported by the IBM AFP Workbench Viewers,

Form Definition: *.fde,*.FDE
JFIF: *.DOR,*jpg, *.JPG,*.jfif,*.jpeg
GIF: *.DOR,*gif,*.GIF
TIFF: *.DOR,*.tif,*.TIF,*.tiff,*.TIFF
CHARSET: *.240,*.300,*.OLN,*.oln,*.Oln,*.fnt
CODEPAGE: *.fnt
CODEDFONT: *.FNT

IBM AFP Workbench Viewers only allow you to view and print AFP/IPDS document but does not create AFP/IPDS document, page segment, medium overlay, or overlay.
Top Level Intro

This page is printed before a new top-level chapter starts.

Part XIII
13 Purchase

Why to buy?

The evaluation copy of Virtual IPDS Printer expires after 15 days. You can purchase the full version of the software through our channels worldwide.

For more information on purchasing,

http://www.ipdsprinter.com/order-virtual-ipds-printer.html

Billing & Payment

Billing currency: USD, EUR, GBP, AUD, CAD, JPY, CHF.

Payment options: Credit card, Debt card, PayPal, Wire Transfer, Bank Check, Purchase Order etc.

NOTE: The simplest and fastest way to buy our software is to order it Online.

Benefits of Purchase & Registration

After you purchase the full version, you will receive:

- Use of the software beyond the 15-day trial period
- No registration reminders or trial version watermarks on AFP/IPDS files
- Free updates & upgrades to the latest version & future versions.
- Product support by e-mail totally free.

Delivery Options

You can choose either of the following delivery methods:

1) Download: You will receive a download link to the full version immediately after your order is processed.

2) Download + CD: You will receive a download link to the full version, and the full version software will also be mailed to you on one CD-ROM.
Top Level Intro

This page is printed before a new top-level chapter starts

Part XIV
14 Registration

How to register your copy of Virtual IPDS Printer?

Before registration you need to obtain a valid license code to turn your evaluation copy into full version copy. If you don't have a license code, you can purchase one from our store,

http://www.ipdsprinter.com/order-virtual-ipds-printer.html

To register Virtual IPDS Printer with your license key, you should provide your registration name as well in the Registration Reminder window. Both the license key and the registration name can be found in the order confirmation email sent by our reseller.

If you have trouble in registering Virtual IPDS Printer, feel free to contact our support team at support@ipdsprinter.com.
Top Level Intro

This page is printed before a new
top-level chapter starts

Part XV
15 **Support**

If you have any question, feel free to contact us.

**Contact Sales Representative**

sales@ipdsprinter.com

**Contact Technical Support Staff**

support@ipdsprinter.com

**Contact Reseller in North American**

Share-it  
c/o Digital River, Inc.  
10380 Bren Road West  
Minnetonka, MN 55343, USA

Languages: English

Phone: +1 952 646-5747 (for calls from outside the U.S.) or +1 800 903-4152 (for calls within the U.S.)  
Fax: +1 952 646-4552

**Contact Reseller in European**

Share-it - Digital River GmbH  
c/o Digital River Ireland Ltd.  
Unit 153  
Shannon Free Zone West  
Shannon Co. Clare  
Ireland

Languages: English, German, French, Italian, Spanish and Portuguese

Phone: +49 221 31088-20  
Fax: +49 221 31088-29
Endnotes 2... (after index)